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INTRODUCTION
Sierra Nevada, California, January 1848
James Wilson Marshall, a carpenter building a
water-powered sawmill found flakes of gold in
the American River. “It made my heart thump,”
Marshall recalled later.
His discovery sparked the Gold Rush. Throughout
1849, thousands of would-be gold miners, known
as ’49ers, spent their life savings or borrowed
money to travel to California and chase the vision
of fabulous wealth.
Anno 2015, the basic prospecting ideas are the same: locate a
‘claim’, gather your mining gear, and sift, sift, sift until you
strike ’gold’.
Yet:
! We do not have to travel to Sierra Nevada to prospect
gold. The digital goldmine is right at our fingertips.
! We do not sift soil. We mine DATA.
! And while the Gold Rush was over almost as quickly as it
started, the global digital market is getting stronger
by the day.
1.01 billion people actively use Facebook each day.
The number of monthly active users is 1.55 billion. 1.55
billion!!! The potential of reaching even a small fraction of this
audience is definitely something to ‘make our hearts thump’…
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Facebook provides us with a
virtual goldmine that we can
reach 24/7.
All we have to do is to sign on,
create an ad and send it to clients
whose fingers are burning to click
on the magic ‘give me’ button.
OK, that sounds easy. But wait:
send the ad to which clients?
There are hundreds of millions of them! And there are
thousands of promoted posts competing with our ad!!
It’s too much – is the FB goldmine caving in on us before we
have even started? What do we do?
It’s simple. We will systematically sift through FB’s
database until we strike gold: craving converting clients.

Crimes and Conversions
Data mining? Sifting through databases?
“That’s not for me. That’s for the geeks!” You might say, brow
knitted, ready to move on to another product.
No worries. You do not need to be a geek or a rocket scientist
to crack the Facebook code. You can do it even if you skipped
your middle school math.
I will show you step-by-step how to master the data
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Facebook provides.
These simple, easy to follow steps will put you in charge and let
Facebook work for you. No more confusion, no more
information overload.
I am saying this based on my experience.
During my career I ran thousands of data analyses and
consulted businesses in many different fields – from modeling
physiological processes in humans to simulating potential
safety risks in power plants, from optimizing organizational
processes to detecting fraud in multinationals.
Regardless of the field, the goal was always the same: crunch
gazillions of data and find the ‘knobs one can twiddle’1 to
create the desired outcomes.
In my previous job I was a director of a research center for
forensic psychiatry in the Netherlands. This was a very
challenging and rewarding job. However, for family reasons I
moved back to the USA and started my marketing business,
which, in many ways, is a natural continuation of both my preforensic and forensic careers.
One of the responsibilities of the
research center I ran was to
support forensic professionals in
assessing offenders and
identifying those at risk of
reoffending with a serious crime.

1

As Douglas Hofstadter put it in his book Metamagical Themas.
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Needless to say, assessing offenders has huge consequences for
societal safety as well as for the offenders in question. It’s a
nightmarish task – if not done correctly, the lives of many
people will be affected.
Yet, predicting people’s future behavior is enormously
challenging. People change, situations change, the amounts of
available data are overwhelming, the amounts of not available
data are daunting. It’s impossible to get risk assessments right
all the time.

Even when performed by experienced forensic professionals,
offender risk assessments are only as good as flipping a coin.
Only 50% of the assessments are correct when relying merely
on the clinical judgment of these professionals. But when
Structured Risk Assessment Instruments are added to the
process, the accuracy increases to 75-80%.
Systematic data analysis improves hit rates!
Why? Because clinical judgment reflects the experience and
subjective biases of individual professionals.
Risk Assessments Instruments, on the other hand, are
questionnaires and structured interviews based on rigorous
Copyright © 2016 ICTX Enterprises, LLC. All rights reserved
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analyses of tens of thousands offenders.
Forensic scientists developed these instruments by
1. collecting demographic, sociological, and psychological
patterns in various populations;
2. studying the differences between offenders and law
abiding citizens;
3. narrowing the data to highly predictive patterns.
Although these methods are not bullet proof - and most likely
never will be - using them increases the accuracy of targeting
reoffenders by at least 50%.
The FB Prospector will show you how to use the same
‘forensic’ methods in marketing.
After all, mining forensic and marketing data is not that
different. Perhaps the biggest difference is that targeting
audiences who engage, buy a report for $7.00, or sign on for
that expensive backend product is not about crimes, but about
conversions ;-)

Math, Matchmaking, and Magical Buttons
People are typically very excited about data mining, but at the
same time intimidated but all the ‘math and technology’…
One of the questions I hear a lot is: “Data mining sounds so
cool… But can we do it without knowing how to run statistical
analyses and mathematical modeling?”
Yes, we can ☺
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Granted, large retailers use sophisticated data mining systems
to identify buying patterns of their customers in order to
increase sales and decrease customer turnover. For instance,
we are all familiar with the ‘people who bought item X also
bought item Y’ feature on Amazon.com.
Such automated analytical
systems are very costly - think
servers, data collecting software,
data processing software, and
high-paid scientists to make
sense of this all. These
investments are justified only
when huge amounts of data need to be processed continuously
and quickly.
Using such systems for our FB goldmine operation would be
comparable to putting a rocket engine into a city car: total
overkill.
We can take advantage of the principles of data mining
without worrying about all the bells and whistles, including the
rocket science math.
One of the principles is that whereas traditional marketers first
identify an opportunity and then gather information and plan
their strategy, data mining uses information that’s already
available.
And here comes the beauty of Facebook: it collects most of
the information we need and makes it available for us. FB also
provides more statistics than we will ever need. All done for us,
ready to be used. Is your heart thumping? Are you smiling? ☺
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So, worrying about math is not
necessary! Besides, marketing
is not math.
Marketing is Matchmaking…
And matchmaking is pattern recognition… and pattern
recognition is fun!
Especially so when one can use Facebook’s fabulous
database.
Facebook’s data collection and tracking tools are marketers
dream. They deliver mind-boggling wealth of information right
to our laptops.
Yet, all the features and endless data combinations could be
overwhelming if not approached systematically.
The FB Prospector will guide you through the data
minefield (no pun intended) so that you can
masterfully allocate, assess and optimize
audiences in order to maximize your results likes, shares, conversions, profits… whatever
makes your heart thump.
Yet, the Prospector is not a magic bullet. It will not make you
a millionaire overnight. It’s a systematic step-by-step
method that helps you
! understand the information FB provides;
! sharply target audiences to match your products;
! master your advertising results so that you can
Copyright © 2016 ICTX Enterprises, LLC. All rights reserved
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# increase your return on investment (ROI);
# continuously adjust to the ever-changing
markets.
Unless you are already a person who puts a dollar in the FB
machine and gets two dollars out, some patient detective work
will be required on your part. Especially so in the beginning of
your prospecting journey.
This work will become much easier as you go on and cultivate
a long-term relationship with your audiences.
Talking about magic bullets, many of us dream about having
the detective work done for us automatically. Large companies
use such systems already, and it’s only a question of time when
small businesses will enter the arena.
In a way, that’s great! We all lead busy lives, the more work we
can delegate the better. We do not need to do all the footwork
ourselves all the time.
Yet, regardless of how much you delegate, understanding the
data related to your business is imperative.
During my consulting career, I met quite a few top managers
and business owners who were passionate about their line of
business, could talk hours about their latest projects and new
ideas, but became painfully uncomfortable when the talk
turned to business numbers.
‘Ugh, let’s do not talk about numbers,’ they would say, ‘I am the
vision guy, numbers are for the birds…’. Or for the
accountants…
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Anyhow, you got the picture. A number of these people just
checked the profit & loss statement as a whole and refused to
analyze it product by product, not realizing that some of their
favorite products are losing money and eating away the profits
made by the less sexy but more reliable products.
When you are running a business, numbers are your best
friends.
Being ‘the vision guy’ is great, as long as your vision and your
numbers work together. Ideas that are not validated by hard
numbers are definitely not your best friends, even when they
sparkle like the most precious diamonds. You bottom line is
the best test for all your endeavors...
Moreover, our world is in a state of flux. Successful marketers
adjust all the time.
Yet, can we adjust effectively if we do not know our crucial
business data? NO!
The most successful entrepreneurs know their numbers
inside out!
Presumably you are in this business to be your own boss. You
do not want to jump through the hoops in someone else’s dog
& pony show, do you? You want to run your own show… and
you want to tailor your strategies to YOUR situation.
Mastering your data gives you freedom, independence,
and competitive advantage:
! while everybody else blindly follows the gurus and hops
from one shiny object to another, you will be able
Copyright © 2016 ICTX Enterprises, LLC. All rights reserved
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CHOOSE strategies that work for you;
! while others discard product after a product without ever
fully utilizing them, you will focus on retaining sharply
targeted clients and increasing your profits.
The FB Prospector will show you
how to turn your data to profits!
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HAVE YOU GOT A HOT ‘CLAIM’?
Or – in modern terms – do you have a niche? If so, go to the
next chapter and sift, sift, sift…
If not, it’s time to stake your own claim. To start with, there are
two basic guiding principles when selecting your niche:
Passion & Profits

Passion and profits – heart and money – are the two extreme
approaches to claiming your fame. Are you going to be a
starving artist who creates passionately day in day out and
does not care about profits? Or do you want to be the
emotionally deprived millionaire who has no time to laugh on
the way to the bank?
Oh wait…. how about being profitable while passionately
working on making your dreams come true?
Do you know where you stand on the Passion vs. Profits
dilemma? If you are not sure, go deep down and explore…
In any event, whether you go for passion or for profits or for
both, you will have to be pragmatic. Regardless of the passionprofits mix in your selected niche, you must have the potential
to deliver successful products. That is, you have to have
access to the skills and resources necessary to become an
outstanding player in the niche.
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SIFT, SIFT, SIFT…
OK, you’ve got your ‘claim’. However, not all pastures are
created equal - the gold is not distributed evenly over your
territory. Which means that we have to seek out the shiny,
profitable ‘pockets’.
Fortunately Facebook provides us with the perfect tool:
Audience Insights, a feature of Ads Manager.
Even if you do not promote your products directly on
Facebook, Audience Insights can help you target audiences that
you can attract, cultivate, and eventually convert to buying
clients.
So, go to your Ads Manager, click on the scroll bar symbol (red
arrow), More Tools and then on Audience Insights. You have
entered a virtual goldmine!

If you did not run any ads from your Facebook account yet, you
will first have to gain access to your Ads Manager. An easy way
to do so is to run a Page Likes campaign to your Fan Page.
If you do not have a Fan Page, skip the following text for now,
go to the section on Courting Your Audiences (page 34), and
proceed to step #13: Create a FB Fan Page.
The next step is to create and run an ad. Click on Create Ads in
the left menu of you Facebook home page. Alternatively, click
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on the down arrow in the blue bar on
the top of you of you FB page (upper
right corner), and then on Create Ads
in the scroll bar menu.
Set up your Page Likes campaign:
- Click on Promote your Page. The
name of your page should be
already filled in on the right
side of the form.
- Click on Continue.
- Based on your niche research, estimate the demographic
profile of your audience and fill in locations, age, gender,
languages, and interests.
-

Set up your daily budget ($5.00 is fine).
Leave in the default options in all the remaining budgeting
and scheduling options.
Name your ad set and enter an image fitting with your Fan
Page.
Place the order.
Fill in the requested billing data.
Wait until the ad has been approved, let it run shortly and
stop it (or if you are the curious type who wants to test
everything, let the ad run and compare its performance
with the more targeted ads you will create from step #14
on).

Congratulations. You’ve gain access to your Ads Manager
and are on your way to creating a raving audience!

Copyright © 2016 ICTX Enterprises, LLC. All rights reserved

16

Audience Insights Basics
Let’s explore the territory. Click on Audience insights and
select ‘Everyone on Facebook’. You should see this image:

We can create our custom audience by specifying the
categories in the left column: Location, Age and Gender,
Interests, and other behaviors and characteristics listed under
Advanced.
The horizontal bar above the graphs shows us various facets of
our audience’s profile: Demographics, Page Likes, Location,
Activity, Household and Purchase.
A lot of information? Yes. Mind-boggling? Yes and no.
Facebook certainly provides us with a fascinating dataset. Just
imagine all the stories behind the lifestyles of ‘Full Steamers’,
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‘City Mixers’, ‘Shooting Stars’ and the many other population
groups featured under Demographics. Without a plan, one
could get lost in the endless combinations of age groups,
interests, behaviors, relationships, home types, financial status,
and the related online activities.
Yet, as you will find out soon, it’s rather easy to mine this
dataset and unearth meaningful information.
The key to success is to define crystal clear goals and stick to
your mining objectives rain or shine.
In our case, the ultimate goal is to allocate the profitable
pockets in our niche. In other words, we are seeking fans that
can be converted to leads that will become clients.
Each stage of the search has somewhat different objectives. We
will start with collecting Likes - that is people who Like your
Fan Page. This audience can be then further narrowed to
Leads (potential costumers) and finally to Customers.
However, the methods to analyze the data are the same
whether your goal is to maximize Likes, Leads, or Conversions.
In the following exercises we
will assume that we are
starting totally from scratch.
At first, we will cast our nets
wide to gather general data
concerning FB users in our
niche. As we go on and collect
feedback, we will gradually
narrow and refine our target
audiences.
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If you already have clients, Facebook allows you to create
custom audiences based on your e-mail list and other sources.
Click on the following link to get step-by-step instructions:
https://www.facebook.com/help/170456843145568
For all practical purposes, I will use Internet Marketing (IM) to
demonstrate the steps on our journey towards lucrative
audiences. To gain the most value from this exercise, please
use your own niche and carve out the profiles of your potential
clients.

Zooming In
#1. Are you ready to explore? Go to Audience Insights. Start
your search with one country - it’s the cleanest approach
to assess your audience, as audiences can be vastly
different from country to country.
a. An ‘All United States’ audience will result in 150m –
200m monthly active people; this number is in the left
upper corner under (New Audience).
#2. Go to Interests and ad as many interests relevant for your
niche you can think of.
a. In the IM business, the
first cut could include
interests such as Digital
marketing, Online
advertising, Email
marketing, Facebook
advertising, Marketing,
Affiliate marketing, Cost
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per Action, Social media marketing and so on.
b. This combination of interests results in a very wide
audience of 20m-25m monthly active people. This
audience is still too large for our purposes and we will
scale it down later. But before we do so, let’s get
familiar with this audience.
#3. Explore the various segments of your own audience per
interest. See how large these segments are, what’s the
men:women ratio, which pages they like, what’s the
income distribution and so on. Note how your niche differs
from the total FB audience, which is displayed in gray.
a. For instance 350k-400k people, 47% women and 53%
men, are interested in Affiliate marketing and, among
others, like JasonNybackfan and Michelle Pescosolido
(the information could be considerably different when
you read this document, as FB is constantly updating its
database).
b. Remark: Some interest segments of your audience
could be too small to produce any data. It’s up to you
whether you will leave them in or not, as they are not
likely to affect the overall statistics of your audience.
c. Save this ‘all in’ audience for further reference.
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Tell Me How You Measure Me…
An old adage says: “Tell me how
you measure me and I will tell
you how I will behave”.
Audience Insights provide us
with various possibilities to
‘measure’ our audience.
Because we are seeking fans and clients who take actions
(click, buy, share…), we want to measure the engagement
level of our audience on Facebook. In FB ‘currency’ we are
looking for people who Like, Share, Comment, and Click on
Ads.
Engagement is an important indicator in the FB world. It
gives us feedback about our customers preferences, it tells us
what they value, what excites them. Further, high engagement
triggers Facebook to show our posts etc. to more people.
Positive engagement (such as Clicks, Conversions, Likes,
Shares) also plays role in Facebook’s Ad Relevance Score,
https://www.facebook.com/business/news/relevance-score.
High Ad Relevance could lower the cost of ads and so increase
your profits!
So let’s continue our exercise with engagement in mind.
#4. Using the audience you created in step #2, click on Activity.
You should see a graph similar to the one below.
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a. It turns out that the wide IM audience is much more
active than the typical FB user:
Pages
Liked
IM
audience
FB user

Comments

Posts
Liked

Posts
Shared

Ads
Clicked

41

27

34

7

33

19

6

8

1

6

b. How does your niche behave? Record its Activity
metrics.
Now, let’s stop for a second and think about this: 34 Posts
Liked per month! That’s about 1 Like per day!!!!!
Granted, Likes are not conversions. They are not huge golden
nuggets. Unless you live for Likes, of course ;-)
Nonetheless, Likes, Comments and Shares are tiny flakes of
gold. Precious flakes if we want to cultivate solid following, a
crowd that trusts us. And, as we have learned from James
Copyright © 2016 ICTX Enterprises, LLC. All rights reserved

22

Wilson Marshall, flakes can trigger a gold rush!
Anyhow, let’s see how our competition fairs in this Likeable
land.

Competition Unmasked…
#5. Identify several major competitors
in your niche.
#6. Per competitor, create a new
audience where the competitor is
the only interest. Study the
profiles of these audiences.
a. Remark: brands or individuals have to be quite popular
to make it to ‘Interests’, thus it’s possible that not all of
your competitors will appear.
b. If none of your competitors makes it, do not despair –
you’ve just got the opportunity to be the first one to
brake through in your niche ☺
In the meantime learn from the IM branch…
c. … where we will go directly to the ‘gurus’.
Let’s face it: the gurus are not necessarily liked – in real
world terms ;-) – but they get lots of Likes. And they
sell!
The table below shows an ‘Activity’ overview of audiences of
five IM gurus.
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Pages
Liked
58
58
62
67
72

Guru 1
Guru 2
Guru 3
Guru 4
Guru 5
IM
41
audience
FB user
19

Comments Posts
Liked
31
36
32
37
32
33
32
41
37
44

Posts
Shared
13
13
15
12
15

Ads
Clicked
34
35
36
30
32

27

34

7

33

6

8

1

6

We can safely conclude that when it goes to Activity, the guru
audiences are definitely way ahead of the typical FB user. And
they are also more active than the wide IM audience, especially
so concerning ‘Pages Liked’ (a life time indicator) and ‘Posts
shared’ (30 day indicator).
Please note that these values are continuously changing as FB
updates its database. Nonetheless, the gurus attract dynamic
audiences. No two ways about it. Pockets of gold in the FB
goldmine, if you will.
But what’s in this for you?
To start with - whatever niche you are in - studying the
audiences of your competition provides you with invaluable
information. What do these people like? Which pages,
products, public persons, politicians… What’s their income,
their lifestyle… What get’s their attention, what moves them?
Looking at the audiences of the five gurus, we will certainly
find similarities. Lots of ‘Savvy Singles’ and ‘Urban Tenants’.
But the audiences are by no means the same! There is
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overlap, yet each guru has own following. And so can you!
#7. Study the differences
a. in the audiences of your competitors
b. in the products of your competitors
Where does your product fit in? What are the similarities and
differences when you compare your product with the products
of your competitors? What’s the big idea behind your product?
What’s its appeal?
If you do not have a product yet, use the information you
collected in step #7b as inspiration for selecting one…
Understanding the audiences of your
competition gives you a basic ‘reading’ of
your niche, and can tremendously help
you target your own products.
However, you will have to do some finetuning in order to find the audiences that
crave YOUR products.
Before we go on with further sharpening and refining your
target crowd, let’s look how Audience Insights compose
audiences.

Audience Insights Logic
We can specify our audience and increase or decrease its size
by using the categories in the left column of Audience Insights.
For instance, the whole US FB audience is 150m – 200m
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monthly active people. If we limit it to the 25-34 age segment,
we end up with an audience of 45m – 50m. If we add the 35 –
44 age segment, the audience goes up to 80m - 90m.
Thus adding segments WITHIN the left column categories
will likely increase the size of the resulting audience. The
size of the increase depends on the overlap between the
segments, as is shown in the drawing below.

The target audience will consist of people who have EITHER
interest A OR interest B OR both interests. This is called the OR
function in logic. The following table shows which FB users will
be included in an audience depending on the affinity for
interest A or B.
has interest A

has interest B

included in audience

yes
yes
no
no

yes
no
yes
no

yes
yes
yes
no

On the other hand, adding left column categories – Age,
Gender, Interests, Connections, and the categories under
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Advanced – will decrease the resulting audience.
For instance, 1m – 1.5m people
are interested in ‘Digital
marketing’ (Interests). By further
specifying their behavior as ‘Small
business owners’ (Advanced ->
Behaviors) will decrease this
audience to only 100K -150K, as,
according to their FB records, the
majority of small business owners
(4.5 -5m total) is not interested in
digital marketing!
Thus only people who are interested in ‘Digital marketing’ AND
are small business owners will be part od the target audience
(the area in magenta). In logic this is an AND function.
interest I

behavior B

included in audience

yes
yes
no
no

yes
no
yes
no

yes
no
no
no

Sharpening and Segmenting
Enough theory, let’s return to your own audience.
#8. Refine the audience you created in step #2.
a. Use the intelligence collected in step #7 to ensure that
the selected interests are relevant and that key interests
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are not missing.
b. Go to Advanced and specify all the behaviors,
relationships, market segments etc. that are absolutely
essential for your product.
Thus if you have a product that is meant exclusively for
single parents of children aged 4-12, select these
categories. You obviously do not want to spend your
advertising money on singles without children or on
empty nesters.
However, as we will discuss in more detail later, you do
not want to narrow your audience too much at this
point. You do not want to exclude potential clients
before you had a chance to connect with them. So if you
do not have any obvious market restrictions, do not
specify anything.
c. Check the size of the audience. When running to cold
traffic, the recommended size of the audience is 500k –
1 million people. If your audience is too large, trim it. If
it’s too small, add more interests. Your audience
will probably not reach the recommended size in some
smaller niches. It’s the same for your competitors, thus
run with what’s available.
d. Record the Activity metrics of this audience.
#9. Now click on Demographics and study the age and gender
distribution of your audience. Your distribution (in blue)
will most likely differ from the typical FB pattern (gray).
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For example, above is the age and gender pattern of the
audience of Guru 1. We can see that this audience
comprises 51% women and 49% men, and its majority is
in the 35-64 age category.
#10. If your audience shows a large gender imbalance (for
instance 75% women, 25% men), limit the audience to
the dominant gender.
#11. Limit the audience to the age segments that are ‘overrepresented’, that is have larger percentage of the
audience than the typical FB pattern. In the example
above it would be 35-44, 45-54, and 55-64.
The 55-64 category seems somewhat less ‘hot’, i.e. is not
as much overrepresented as the two younger categories.
We would probably not include the 55-64 category in a
sharper targeting regime, but would keep it in during the
first exploratory stage.
If relevant, consider narrowing the audience further,
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perhaps using household income or other characteristics
of your audience such as education and so on.
Why do we narrow the audience like this? Because it’s easier to
catch a fish in a full pond than in an empty one.

By limiting the audience to the overrepresented segments, we
are increasing the ‘density’ of the population interested in our
products (see the drawing above).
The FB search algorithm can reach only a small percentage of
our potential clients. When we focus on the areas where more
‘gold’ can be found (magenta dots in the drawing), our search
will be not only more effective, but potentially also more
efficient due to higher click through rate, higher engagement,
and lower CPC.
Nonetheless, we should not limit our audience mechanically or
thoughtlessly. We have to check how the narrowing affects the
targeted behavior of the audience, which is in this case Activity.
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For instance, the wide IM audience has the age distribution
shown below.
On the first sight it would make sense to remove the 18-34 age
category. However, doing so actually decreased the activity of
the audience!
Since this is a large audience, it makes sense that various
segments (in this case age categories) show different behaviors
and require different marketing strategies. As it turned out, 2534 year old women are the most active segment of this
audience. Yet, would they crave our products?

#12. Check the activity of the audience you’ve created in steps
#8 - #11.
a. If the Activity metrics are pretty much the same or
somewhat higher than the metrics you got in step #8d,
you are ready to test this audience in practice.
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b. If Activity decreased, investigate the Activity metrics
per age segment and gender to identify the segments
most suitable for targeting. You may also elect to use
the whole audience and see how the various segments
respond to your campaign.
c. Create several different test audiences based on
different interests, gender, age, household income and
so on. Save these audiences in Audience Insights, so
that you can easily activate them when you are setting
up your campaign.

Second Thoughts About Your Hot Claim?
We went on with the previous exercises assuming that you
have already selected your niche, and are passionate enough
about it to put in the work and cultivate your audience.
But what if your passion is to find
the hottest niches around,
regardless of what they are all
about? In that case you can
approach the niche selection like a
true data miner who makes the
maximum use of information that’s
already available.
If that’s you, reverse the process we just went through.
! Rather than starting with a pre-specified niche and
unearthing the behavior of the related audiences, start
with identifying audiences that have high spending
power and high engagement on FB.
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! Study the Page Likes and preferences of these
audiences to identify the products they desire.
! Assess what kinds of skills and resources you need to
successfully market these products.
It’s up to you. After all – as been said many times in this
business - it all boils down to offering a hungry crowd a
product they crave. And hopefully adding value to the crowd’s
experience ;-)
By the way, did you notice there is RAVE in cRAVE?
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COURTING YOUR AUDIENCE
In the previous chapter we’ve mapped your ‘hot claim’ - your
niche - based on the data provided by Audience Insights.
However, a map is not the territory. Now it’s time to get ‘out
there’ and explore the territory ‘on foot’.
We will test the waters lightly, by creating a Fan Page and
running a Like campaign.
The goals of running the Like campaign are to
1. explore which segments of your audience Like your message
2. collect at least 1000 likes, which enables us to create a
comparable but much larger Lookalike audience.

Create a FB Fan Page
#13. Create a Facebook Fan Page dedicated to your niche or
product.
We need a Fan page to run ads on FB. If you have never made a
FB Fan Page, please follow these steps.
- Click on the down arrow in the right upper corner of your
FB page.
- Click on Create a page.
- Select the type of Page. Unless you are creating a specific
page, Cause and Community works well.
- Enter the name of the page.
- Download the profile picture (180 x 180 pixels).
- Skip the next steps.
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Download the cover picture (851 x 315 pixels).
Tip: a picture is worth a thousand words. Select unique
images for your page’s profile and cover photos. Images
that reflect the story of your business.
- Go to the About page and fill in all the information. This
will increase the credibility of your page.
- Post several items on the Timeline of your page. You can
use your own content or the content of someone else in
your niche.
- Post regularly (at least once per day) when you run the
first Page Likes campaign.
-

Ready for the Likes Race?
#14. Set up a Likes campaign (Page Promotion).
If you do not have experience with setting up a Likes
campaigns, please follow these steps:
- Click on the down arrow in the right upper corner of your
FB page.
- Click on Create a page.
- Click on Promote your Page. The name of your page should
be already filled in on the right side of the form.
- Click on Continue.
- Enter the name of your custom audience (created in steps
#8 - #12).
- Set up your daily budget ($5-10 per ad per day should be
sufficient).
- Leave in the default options in all the remaining budgeting
and scheduling options.
- Let FB determine the Cost per Click. You could also
determine how much you are willing to pay per click (CPC
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-

mode), but this could limit the reach of your ad and thus
limit the data you are collecting.
Name your ad set and enter an image fitting with your Fan
Page.
Select whether you want to run on desktop or mobile.
Place the order.
a. Create several ads using your various audiences and
ads creative. If desirable, create different audiences,
for instance one wider and one narrower.
b. If possible, test men/women, desktop/mobile in
separate ads. If you run your ad to desktop & mobile,
FB will most likely send the ad to mobile only.
c. Test different images in separate ads. You are allowed
to submit up to six images in one ad set, but FB will
probably not use the images equally.
d. Run all these ads at the same time to ensure
comparable conditions. Users behave differently on
different days, so it’s not wise to compare ads that ran
on Monday with ads that ran during the weekend.
e. Run the campaign at least three days before you make
any adjustments. Do not jump to conclusions too early,
as it takes a while before the performance of an ad
stabilizes. Early results can be unreliable.
f. Do not panic when your ads do not run or are
underperforming after you have changed something.
Again, it can take a while before things get to ‘normal’.

If you do not want to spread yourself too thin and do not want
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to create separate ads for all the different segments of your
audience, you may lump some of the segments together.
The FB reporting tool will allow you to analyze these segments
separately (we will get to this this in step #15d). However, you
will possibly end up with less precise data, because FB will
most likely not serve your ad equally to the various audience
segments you are targeting within this ad.
The main reason why we want to test parts of your audience
separately is to avoid a so-called statistical washout, that is an
outcome that hides the underlying effects.
Let’s assume that men’s interest in something decreases with
age, whereas women’s interest in the same thing increases
with age. If we do not measure men and women separately, but
combine their level of interest per age group, we will end up
with one flat line (magenta in the drawing below), one flat
zero, which does not tell us anything….
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Magic Mirror on the Wall, Who Gets Most Likes of All?
Ready to analyze the results of your explorations?
#15. Go to your Ads Manager
a. Click on All Campaigns -> All Ads
b. Click on Columns: Performance -> Customize columns
c. Select the metrics you want to view. The most
important are Pages Likes, Cost per Page Like, Clicks,
Cost per Click, Click-Through Rate, and Amount Spent
d. Determine the Breakdown categories (Age or Age and
Gender are recommended)
e. Export the report (.xls, include summary row)
I will explain how to analyze the report using the results of my
campaign.
For the purpose of this training, I created a simple Fan Page
called Internet Marketing News and Views.
To start with, I created two audiences.
a. A wide audience (described in step #2a)
b. A narrower audience comprising four gurus and
interests such as digital marketing and affiliate
marketing.
Finally, I created five Like campaign ads and ran them three
days.
1. Wide audience, age: 24-65+, desktop & mobil
2. Narrow, women, 24-65+, desktop
3. Narrow, women, 24-65+, mobil
4. Narrow, men, 24-65+, desktop
5. Narrow, men, 24-65+, mobil
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When I ran this campaign, Page Likes and Cost per Page Like
were not yet available, so I optimized the campaign using
Clicks and Cost per Click (CPC).
However, as soon as Facebook introduced Page Likes and Cost
per Page Like, the values of these metrics were provided
retrospectively for my campaign. I compared the outcomes,
and, in this particular case, Clicks and Page Likes as well as CPC
and Cost per Page Like are comparable metrics.
Thus it does not make any difference whether I optimize the
campaign on Clicks & CPC or the new metrics Page Likes & Cost
per Page Like: the results are the same.
Yet, since Page Likes are the ultimate outcome of the Page
Likes campaign, please use these new metrics in your analysis.
And now back to our campaign: the goal of this exercise was to
gather information about our audience and learn which
segments Like our page.
OK, let’s see what kinds of golden flakes we’ve gathered…
Please note that for proprietary reasons the values in the
following excel files were somewhat altered. However, the
values reflect the campaign’s results and as such are sufficient
for training purposes.
#16. Open one of the reports you downloaded (I will be using
the breakdown by age)
a. Copy the whole page and paste it into a new Excel file.
This is a precautionary step, as files downloaded from
FB tend to disintegrate upon data analyses.
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b. I’ve arranged the columns so that the most relevant
columns are all next to each other. Moreover, for those
of us who like to look at things from different points of
view, I’ve added an extra column: clicks per $ (which is
just a reversal of cost per click):

c. Select the CTR (click through rate) column and sort it
in descending order. Do not forget to select ‘Expand the
selection’ so that the whole document and not only the
column will be sorted.
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d. CTR is not our ultimate outcome, but it gives us
indication concerning the overall attractiveness of our
ad, especially the image. In theory, higher CTR should
lead to lower cost per click (CPC), but it’s not always
the case. The ads with better than average CTR are
highlighted in blue:
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e. Now select the Clicks/Page Likes column and sort in
descending order. This analysis is in line with our goal
to collect golden flakes ☺ The ads that delivered the
most clicks (= likes) are highlighted in light green.

Note that not all ads with high CTR are also high on clicks. This
could indicate that the ad image was attractive to click on, but
the content was not interesting enough to be Liked.
What we do about this depends on our objectives:
! if we are mining data to find out audiences that Like
our images and content, we do not need to worry
about this and continue our quest with the ‘high
Likes’ segments of our audience
! if – for whatever reason – we want/need to reach
the audience segments that did not like us, we must
create a more fitting content for this segment.
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f. Now: yes, we want clicks, but we also want to know
how much these clicks cost. So select the CPC column
and sort it in ascending order this time.

g. The overview above tells us which ads delivered the
cheapest clicks. Important information, yet, the
absolute CPC is ultimately not that important,
provided that EPC (Earnings per Click, to be discussed
later) is higher than CPC. But we are not so far yet. At
the moment, we are buying clicks to get information
about our territory, and CPC is part of the information.
And, as they say, on Facebook one has to pay to play…
h. CPC is determined by a number of factors such as
country, platform, marketplace (niche) competition,
target audience, and ad performance history. However,
we should not get obsessed by CPC, and certainly not
at this stage of the game. Right now, rather than
focusing on the seemingly most efficient ads, we want
to merely disregard ads that do not deliver (in pink in
the overview under #16f).
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Likes Race continued…
#17. If you have not reached at least 1000 Likes in the first
three days, which is not to be expected in many niches,
adjust your ads so that the non-delivering segments are
eliminated and keep running. If the results of the first
three days inspired you to create new audiences or
experiment with new images, this is the perfect time for
doing so. However, if you want to compare your new ads
with the old ones, run them on the same days of the week.
Besides eliminating the lame segments of the audience, I tested
three new audiences:
1. Gurus only (and no other interests)
2. Digital marketing (and no other interests)
3. The narrower audience from step #15 further narrowed
by a behavior: small business owners
I also experimented with various images, and ran several ads
to the right column (which was not a success), as well as
boosted several posts to see which images and content people
like.
After several more days, Internet Marketing News and Views
exceeded the magic number of 1000 Likes.
The audience that Liked the Page is relatively young and
comprises 50% percent women and 50% men:
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Further, this audience is rather trigger, eh… ‘Ads Clicked’
happy (see the screen shot below).

We could say that our audience has acute shiny objectitis ;-)…
or amuses itself by clicking on ads.
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BUT: we do not know on which ads they click, and what’s their
conversion rate.
Nonetheless, our objective was to find an active audience in the
Internet Marketing field, and that’s what we’ve got…
We started with a wide IM audience, which is more active than
the average FB user, but not as active as the audiences of the
IM gurus. By running Like campaign to our Fan Page, we have
further refined this audience and created a new audience –
IMNV Likes, which show relatively high engagement:
Pages
Liked
19

FB user
IM start
41
audience
5 Gurus
average 63.4
IMNV
41
Likes

Comments Posts
Liked
6
8

Posts
Shared
1

Ads
Clicked
6

27

34

7

33

32.8

38.2

13.6

33.4

35

39

15

57

Our audience Liked less pages than the guru audiences.
However ‘Pages Liked’ is a lifetime measure and our audience
is younger than the audiences of the gurus, which could explain
the difference.
Moreover, our audience shows more clicks on ads than the
guru audiences.
! And now it’s your turn to analyze your results.
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Do not want to wait for 1000 Likes?
Obtaining 1000 Likes not only enables you to create a large
Lookalike audience, which resembles the audience that
actually Liked you page (see step #18), but also provides
valuable social proof for your Fan Page, which can help to
improve the performance of your ads.
However, if – for whatever reason – collecting 1000 Likes is
not a viable solution for you, skip steps #17-20 and apply the
processes described in the Gather You Mining Gear section (p.
52) and in The Gear Chest (p. 65) to
! create a Lead Magnet;
! run traffic to it via FB Promoted (Boosted) Post or
Unpublished (‘Dark’) Post; use the information from step
#16 to create your audiences;
! collect the email addresses of prospects who downloaded
the Lead Magnet (opt-in form);
! track these leads with a FB tracking pixel.
Once you have tracked 100 people who downloaded the Lead
Magnet, you can go to step #18, create a Lookalike audience
based on these leads, and you are on your way to identifying
and claiming warm audiences that are interested in your offers.

Copyright © 2016 ICTX Enterprises, LLC. All rights reserved

47

Expand Your Territory
#18. When you have reached 1000
Fan Page Likes, use Facebook
to create a Lookalike
audience based on these
Likes: Ads Manager ->Tools ->
Audiences -> Create Audience
-> Lookalike audience ->
Source: your Fan Page ->
Optimize for similarity (2.4 million people).
It can take FB a day or two to create the Lookalike
audience, but the results are worth waiting for!
FB has done tremendous job for you: it put together a
relatively large group of people who are similar to your
Fans. Thus you can now send your posts and/or ads to a
likeminded audience that is more likely to engage than
cold public. This can result in higher Click Through
Rate, lower Cost per Click, and finally in higher
conversion rates and profits!
#19. Go to Audience Insights and enter your Fan Page under
‘People Connected to Your Page’. Study the
‘Demographics’ and ‘Activity’ of the audience that Likes
you page. Is that what you have expected?
#20. Study the ads/audience segments, which delivered
promising results and consider how the audiences can be
further refined.
If your goal was to create a Facebook Fan Page, get you
message out there, and find audiences that Like it, the hardest
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part of your job is done ☺
You, just as the rest of us who want to monetize our Likes, can
of course go on and refine your audiences and sharpen your
communication with them.
You can experiment with new images and
content, use Fan Page Insights to see which
posts get the most engagement, what’s the
best time to post new post and so on.
The most important part is that you carefully measure the
results of your experiments and keep only strategies that
‘enrich’ your audience and you. That is strategies that lead to
higher rates of Likes, Clicks, and Conversions.
In the 20 steps we have just completed, we based our targeting
efforts on facts – demographic characteristics of FB users,
measured activity of these users, real Clicks and Likes collected
on our Fan Page.
When you go on and promote products, you can replace
Likes with Conversions and use the same methods to
analyze your results in order to identify highly converting
audiences.
However, although facts are essential for our operations, we
have to realize that measured ‘facts’ can contain errors and
rarely tell the full story. Which can lead to the fallacies
described in the next section.
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False ‘Facts’: Fake Gold, Ugly Ducklings and Fuzzy
Logic
In technical terms we are talking about false negatives and false
positives. The nightmares of forensic psychiatrists.
False negatives are offenders who seem
to be fully rehabilitated, but reoffend the
moment they are allowed back to society.
False positives, on the other hand, are offenders who are
deemed dangerous and remain incarcerated although they
would have never committed a crime again (but nobody will
know, because they are incarcerated).
In marketing terms we are talking about promising prospects
whose profiles look like profiles of buyers, but who will never
buy anything from us.
And then there are people who would be
loyal fans and buyers but slip through our
nets because they do not fit our swan-like
client profile. Or because FB’s search
algorithm never reaches them.
These errors are inevitable and we should not lose sleep over
them (luckily we are not forensic psychiatrists… ). But we can
keep working on refining our targeting so that we keep our
lists and audiences as clean and ‘alive’ as possible.
Moreover, audiences are not sharply defined entities that
either buy or don’t. Their behavior does not follow the easily
predictable ‘Yes or No’ logic. Audiences are fuzzy. Sometimes
they buy and sometimes they don’t. Some people will buy all of
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your products, others only one or two.
In this sense, the art of targeting is in keeping the nets tight
enough so that not much fake gold gets in, but not too tight
so that not many duckling/swans slip through.
Again, it all boils down to testing, testing, and more testing…
and patiently, systematically and consistently converging on
the crowds that crave our products. And rave about them!
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GATHER YOUR MINING GEAR…
So you’ve staked your claim, mapped your territory and
reached out to potential customers.
The next step is to build your goldmine. Which means creating
- a lead magnet
- an opt-in page
- a FB Boosted Post/Ad
- set up tracking
- follow up marketing strategies (FB ads, e-mails...).
If you have not done these tasks before, go to the Gear Chest
(included in this document), which will guide you along the
way.
However, before you start, you have to consider your
marketing funnel. Funnelology is too big a subject to cover
here. There are various – at times opposing – approaches to
funnel design. Some people start with a big bang and sell their
big-ticket product on a webinar for thousands of dollars, others
start with a $7.00 .pdf and work their way up through a series
of upsells and downsells.
Regardless of your strategy, when you strike gold, mine it
ASAP. Immediately is the best. Have your funnel ready to go
and strike the iron when it is hot.
However, when you are new to a niche, it makes sense to test
the front end of your funnel before you put a lot of time into
developing your product. So experiment with various lead
magnets to segment your audiences and to find out what they
like.
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Another golden rule is to make your funnel consistent. Your
lead magnet should reflect your offer or be its mini version or
one of its segments. And so should all the other products in the
funnel fit together, even though they are self-standing units
that can be used without having to purchase the next product
in line.
In the next chapter we will discuss ways to make your funnel
profitable.
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GOLDEN TRAFFIC: every nugget counts…
You’ve got your territory all mapped out and your mining gear
in place, so now it’s time to make your FB ‘mine’ productive.

Terrific traffic: get the goldmine up to speed
Below are a few basic tips for setting up a FB campaign,
whether you are promoting your lead magnet or your back-end
product.
Now, we have to keep in mind that there is only one thing
certain about running ads on Facebook: the platform is
changing all the time. So these tips are just that – tips; not rules
carved in stone.
- Determine your daily budget and divide it by ten – the
resulting number gives you the number of ads you will
have to run.
Thus if you have $50 to spend per day, make five ads,
each with $10 budget per day. This approach seems to
perform better than one ad with a large budget, as it gives
us more opportunities to zoom in on high converting
audience pockets.
As we said, audiences are fuzzy. Sometimes they buy,
sometimes they don’t. And even though we are targeting
as sharply as we can, some segments of our audiences are
hotter then others regarding each particular product.
The sketch below reflects why deploying more ads
increases our chances of finding these hot segments.
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Ads 1 and 4 hit the
target, while the
remaining ads will
not perform as well.
Further, it’s also
possible that not all
hot pockets will be
discovered.
Thus when ads are not performing as expected, or are
‘slowing down’, starting a new batch could remedy the
problem (provided the product converts!).
- Bid higher then the highest cost per click (CPC)
recommended by FB – you will most likely not pay as
much as you are bidding, but your ads will be shown
more often, which should result in a higher CTR.
- Send the ads to audiences that are familiar with you, such
as the Lookalike audience created in step #18 or an
audience created based on your list.
- Let the ads run a full day.
- Use the methods from step #16 to identify ads that
perform the best according to your goal (Likes, list
generation, conversions, average sale amount…).
Duplicate these ads. Delete all less performing ads.
- Gradually decrease the CPC bid, but keep checking that
your ad is being shown and your CTR does not go down
as your CPC decreases.
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- Keep identifying and duplicating the best performing ads
and stopping all other ads.
Again, FB is in constant flux, so please keep in touch with new
developments to stay on the top of the game.
When in doubt, or when you get stuck, consult FB’s Blueprint,
which provides a lot of useful information for free:
https://www.facebook.com/blueprint
And – most importantly – stay focused on your goals when
selecting your strategies and tactics. Make sure new strategies
support your goal rather than distract you and take your
attention away from what you want to achieve.
Running traffic can seem like dealing with one giant black box.
You throw money in, and, if all goes well, more money comes
out.

But what to do if less money comes out than in? Or if we want
that more money comes out?
Most of us in the Internet Marketing business are subjected to
a continuous flow of trainings, webinars, and product offers –
otherwise known as shiny objects – that promise to boost our
earnings and/or catapult us to financial freedom. Do X and
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increase your ROI by 300% in two days, do Y and solve all your
problems in four easy steps…
And, as we all know, not all that glitters is gold. Of course, it’s
beneficial to learn from others. Yet, successful learning implies
that we know how to evaluate what works and what does
not. So in the next section we will turn on our mining lamp and
elucidate the black box.

ROI, CPC, EPC and other trouble
Let’s cut to the chase: if you are in this business to make profit,
your goal is to maximize your return on investment (ROI). In
this segment we will explore how we can increase our ROI. The
equation for ROI is:
ROI =

!"#$%&
!"#$%&'$"&

=

!"#$%$&'!!"#$%&'$"&
!"#$%&'$"&

(x 100 in %)

Thus if you invested $1 and earned $1.50, your ROI is 0.5 or
50%:
($1.50 – $1.00)/$1 = 0.5
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You got out 50% more than you put in.
If your are satisfied with your ROI – be it 20%, 50%, or 200% you do not have to do anything besides making sure that the
ROI consistently stays at this level. Job well done!
However, if you want to increase your ROI, we have to go
deeper, look at more metrics, and see which ‘knobs we can
twiddle’ to achieve the desired outcome.
For us, useful ‘knobs’ are clicks, or rather cost per click (CPC),
and earnings per click (EPC).
EPC =

!"#"$%"
!"#$%& !" !"#!$%

,

CPC is reported to us by FB.
Now we can calculate ROI based on clicks:
ROI =

!"#$%& !"# !"#!$
!"#$%&'$"& !"# !"#!$

=

!"#$%$&' !"# !"#!$ – !"#$ !"# !"#!$
!"#$ !"# !"#!$

Using the same example as above ($1.50 earned, $1.00 spent),
if we used 5 clicks:
* CPC = $1.00/5 = $0.20 (assuming that no other costs were
made)
* EPC = $1.50/5 = $0.30
ROI calculated using the formula based on clicks is:
(EPC – CPC)/CPC = (0.30 – 0.20)/)0.20 = $0.10/$0.20 = 0.5
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The same ROI as when using the formula based on earning and
investment, no black magic here…
Now, this is your ROI isolated to running an ad. In the real
world, when you calculate your overall ROI, you will have to
include ALL the costs you made to run a particular campaign,
product, business: paying for images, outsourcing, overhead
costs and so on.
But for now we will focus on clicks.
On paper, if we want to increase ROI, we have to either
decrease costs (CPC) or increase earnings per click (EPC).
If we want 100% ROI (or ROI = 1), then
(EPC – CPC)/CPC = 1, or
EPC/CPC -1 = 1, thus
EPC = 2CPC.
Thus, using the same example again, if we want to get 100%
ROI, either EPC has to go up to $0.40 (2 x 0.20), or CPC has to
go down to $0.15 (0.30/2).
But we have to be careful, because such
paper calculations can be very misleading!
What if the cheaper clicks result in lower
conversions? Then our ROI could go down
rather then up!
For that reason it’s not recommended to consider CPC without
taking EPC into account.
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We are OK as long as EPC is higher than CPC. If we want to
increase our ROI, it’s perfect to decrease CPC, provided EPC
does not suffer.
Sharp targeting and running to warmer audiences should lead
to lower CPC, but when we cannot decrease our CPC (any
more), we should consider the possibilities of increasing EPC.
To do so, we have to go one level deeper and involve more
‘knobs we can twiddle’ regarding our revenue: number of
clicks, lander CTR, conversion rate, and average sale
amount.
EPC =
EPC =

!"#$%$&'
!"#$%& !" !"#!$%

, thus, using our deeper level knobs:

#!"#!$% ! !"#$%& !"# ! !"#$%&'("# !"#$ ! !"#$!%# !"#$ !"#$%&
#!"#!$%

, or

EPC = lander CTR x conversion rate x average sale amount

Let’s use the following example to get familiar with these
‘knobs’:
ad costs (investment)
$ 10
revenue (earnings)
$ 15
number of clicks
50
CPC
$ 0.20
ROI
50%
average sale
$15
Let’s say that our lander click through rate (CTR) is 10% (0.1)
and our conversion rate 20% (0.2). In this case,
EPC = 0.1 x 0.2 x $15 = $0.3
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Now let’s look what happens when we manipulate the various
metrics:
lander CTR
conversion rate
average sale
EPC
ROI
ROI increase

10%
20%
$15
$0.3
0.5

11%
20%
$15
$0.33
0.65
30%

10
22%
$15
$0.33
0.65
30%

10
20%
$16.5
$0.33
0.65
30%

Increasing the lander CTR by 1% (from 10 to 11%) will lead to
30% increase in ROI: (0.65-0.5)/0.5 = 0.3.
If we want to achieve the same 30% increase without changing
the lender CTR, we will have to either increase the conversion
rate to 22% or the average sale to $16.50.
This opens a lot of possibilities for increasing our revenue…
where do we start? Optimizing landing pages, the product
price, the funnel? Let’s discuss some possible strategies.

Optimizing and testing: top down or bottom up?
My recommendation is to start with the big picture. You can of
course start with testing the color of your download button,
but if the product does not convert, it will not help to have
golden buttons on the landing page, no matter how much your
prospects like them.
! Optimize the funnel as a whole first. Unless you are
testing just the front-end of the funnel, which is a
recommended practice when you are assessing the
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desires of your audience: you do not want to spent a lot of
time developing a fancy products only to find out that
that’s not what your audience wants.
But once you are past the original testing, measure your
overall ROI first, make sure the performance of the funnel
is relatively stable, and then look for potential
improvements.
! Paradoxically, perfecting each element of the funnel
individually does not necessarily lead to the best overall
performance, let alone that it can cost you a lot of time
and money.
For instance, if you increase the price of your offer, it’s
quite possible that your conversion rate will go down, but
it’s OK as long as your ROI goes up.
! Another classical mistake is to focus on certain metrics
separately, without monitoring other metrics (see the
example of CPC and EPC above).
Start with ROI and go deeper level by level to identify
the weakest parts of your funnel, always keeping all
the relevant metrics in mind. If in doubt, keep ROI in
sight. In fact, never lose your ROI out of sight!
! Think first, test second: identify the parts of your funnel
where a small adjustment leads to big improvements and
work on these parts first.
! Keep your goals sharply in mind: whichever tests you
run, ask yourself how much will these tests costs and
whether they will lead to outcomes that at least cover
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these costs.
! Use FB’s Pixel to track audiences and conversions,
measure the performance of your ads and create custom
audiences. The pixel provides priceless feedback and
insight into the behavior of your audiences throughout
the whole marketing funnel.
The FB Pixel is described in the Gear Chest (below).
However, there is much more material to be covered. So I
am planning a specialized training that will go deep into
testing, tracking, and retargeting…
And last but not least, be kind to yourself.
By ‘being kind to yourself’ I do not mean jumping from product
to product and never finishing anything, or making excuses for
not taking action, not installing the dreaded pixels, and
following hunches rather than crunching your numbers.
Being successful requires vision, concerted effort, commitment,
focus, and the resilience to wrestle one’s way through trials
and errors.
It’s perfectly OK to be inspired by stories about becoming
wealthy in two weeks. At the same time, please remember that
overnight success typically takes years – especially so if you
want that it lasts years ;-)
So by being kind to yourself, I mean that you create conditions
in which you thrive. That you genuinely decide what you
want to do, commit, and stick with it no matter what. That you
give yourself the time to proceed systematically, step by step;
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that you allow yourself to test different strategies and learn
from mistakes, so that you steadily gain more and more
mastery of your business.
Thank you again for selecting this training. I hope it was
beneficial for you. I wish you the best of luck and lots and lots
of success.

Dr. Iva Embley
P.S. Have fun! ☺
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THE GEAR CHEST
Lead Magnet
A Lead Magnet is an instrument designed to
! attract traffic into your marketing funnel, and
! create opportunities for you to convert those interested leads - to clients.
Typically you offer something valuable in exchange for an
email address and possibly other (contact) information.
Lead Magnets are like amuse-bouches: free mouth watering
morsels gourmet chefs serve before a meal to demonstrate
their artistry and to get their guests exited about the delicacies
that are yet to come. Just like an amuse, a Lead Magnet should
provide immediate gratification; it must be easily
consumable, spark the leads’ appetite and leave them
wanting more.
Needless to say, being the entry point to your marketing
funnel, a Lead Magnet must be impeccable. You may
outsource the whole production of your Lead Magnet or its
parts, but please make sure that the final product reflects the
offer you are promoting as well as your business approach and
values. First impressions matter!
Talking about first impressions: focus on writing a magnetic
title for your Lead Magnet. Just as headlines, titles can make
or break your conversion rate! A terrific title tells an
irresistible story that will lure your audience into downloading
the Lead Magnet.
To be effective, a Lead Magnet must promise and deliver
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something prospects lack AND seek: SPECIFIC information,
knowledge, a solution. Or a taste of a solution – you do not
want to give the farm away. For instance, a Lead Magnet could
be a mini version of the offer, providing all the what, but not
going into the how to details. Another option is to use one
complete sub-module of the offer.
In any event, the Lead Magnet should establish you as an
expert who can help leads alleviate their pain. Ideally, it
should shift the leads’ mindset from merely interested to
considering engagement with you and your company.
Last but not least, a Lead Magnet ought to provide a specific
solution to a specific market. Trying to please everybody
with one Lead Magnet does not work. It makes sense to
develop several Lead Magnets, each addressing a different
problem. Offering various Lead Magnets will help you test what
your prospects want, and segment them to audiences to
groups that can be sharply targeted.
Lead Magnets could be a
- report or whitepaper
- guide
- infographic or mindmap
- cheat sheet
- training video
- webinar
- case study
- quiz or survey
- assessment or test
- resource list
- free tools or plugins
- software download or trial
and anything else that will help justify buying decisions.
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Opt-in Form Installation
An Opt-in form is the ultimate gold catcher: it enables us to
collect email addresses of people who said yes to an offer. As
such, an Opt-in form is a must for any marketer who wants to
build a LIST.
An Opt-in form can be installed in numerous ways. I will show
you the installation steps for a campaign in which prospects
opt-in (enter their email address) to download a Lead Magnet.
I will use Get-Response (autoresponder service) to set up the
Opt-in form; the Lead Magnet will be downloaded from a
WordPress page. You are of course free to select any
autoresponder and other tools or services that enable you to
build an email list and automatically send follow-up emails to
your leads.
If you do not have a website or a blog yet, please purchase a
domain and get web hosting that is WordPress compatible and
provides WordPress set up. Please note that you need
WordPress.org , as WordPress.com is not suitable for
marketing purposes.
You could get the email collecting job done without having a
website: Get-Response (and other services) will host the Opt-in
form for you. However, you will gain more credibility by having
the Opt-in form on your own website. And you will gain even
more credibility if your website boasts some quality content.
Domain selection tips
For those who are purchasing their first domain, here are few
quick tips:
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! choose .com or .org, because these domains are
perceived as most trustworthy;
! select a domain name reflecting your niche; it helps
when the name contains one or two keywords, but do not
over-optimize it: the name should be flexible enough to
‘grow’ with your business and remain relevant even if you
expand;
! use a name that is short and to the point – something
visitors can easily remember (branding!);
! preferably do not use hyphens as this leads to
undesirable confusion –best-dating-advice.com will get
mistaken for bestdatingadvice.com; moreover, some
people find hyphenating spammy;
! personalize if your desirable domain names are taken –
use names, places, numbers… for instance
Annasdatingtips, 101cookingsecrets and so on; by the
way, this helps with branding as well!
Thank you & Download pages
Now, having completed all the necessary preparations, we can
create a WordPress Thank you page and a Download page with
a link to the Lead Magnet.
! Sign in to your WordPress site.
! Go to Dashboard -> Pages -> Add New.
! Type in the title and the thank you text. This is the page
that people see immediately after they’ve opted in. Here
you inform them that their download is on it’s way, but
that they have to check their inbox and confirm their
email first (see the double opt-in process below).
! Following the same procedure, create another page – this
will be your download page.
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! Click on Add Media, upload your Lead Magnet and Insert
into page.
! Scroll down and adjust the settings of the page:
- full width;
- hide everywhere;
- exclude from list of pages.
The settings may be slightly different in your version of
WordPress. However, the goal is to make this page
available only for the people who requested the
download. The page should not be visible to casual
visitors of your website – you want to collect their emails
first!
! Copy the URL’s of both pages (you will need them for
integration with GetResponse).
! Publish the pages.
GetResponse Campaign
The next step is to set up your campaign and install the Opt-in
form. So let’s go to GetResponse (www.getresponse.com). If
you do not have a GetResponse account, you can sign up for a
30 day free trial.
Once in GetResponse,
! go to Dashboard and click on the down arrow next to
your current campaign (upper right corner) -> Create
campaign;
! name the campaign and once created, click on Campaign
Settings;
! under General, fill in the campaign name and the email
address to which notifications should be sent (the email
will have to be verified);
! go to Permission and fill in the confirmation message*
data: from field (the email address from which the
message should be sent), and message subject; customize
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the message to fit with your Lead Magnet; check the
‘enable confirmed opt-in’ boxes.
! go to Messages (in the black bar on the top of the page),
Create Autoresponder, and create a welcome/thank you
email message, which leads will receive after confirming
their email. It is a good practice to include the link to the
Lead Magnet in this email as well, so that people have the
link in case they did not immediately download from the
Download page.
* The confirmation message is part of a so-called double optin process: people will not be added to your list unless they
agreed to be added to the list and confirmed their email
address. This extra step results in a qualitatively better list
than a list generated by a single opt-in (no confirmation),
because you know that the people who opted-in are interested
in your offer and were not added by someone else. Moreover,
the double opt-in process also minimizes spamming reports.
Some marketers worry about losing the people who do not
confirm, but you probably do not want to have these people on
your list anyhow – committed leads confirm!
Create the Opt-in form:
! click on Forms (in the black bar on the top of the page),
and select Create Form;
! chose a template and design the form;
! click on the cogwheel (form settings) in the upper right
corner (next to save and publish) and fill in the form and
campaign name, tick the ‘add to the cycle on day’ box,
enter your Thank you page URL in the ‘Choose thank-you
page’ field (select custom), and your Download page URL
in the ‘Already subscribed URL’ field. This allows people
who are already subscribed to go directly to the
download without having to reconfirm their email.
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! click on Save & Publish;
! select I will install my web form.
Link the Opt-in form with WordPress:
! go to WordPress -> Dashboard -> Plugins -> Add New;
! search for GetResponse Integration and install it;
! enter your API key (you can find it in GetResponse -> My
Account -> Account Details -> GetResponse API);
! under Subscribe via WebForm click on Go to Widgets site;
! click on GetResponse Web Form, select the position of
your Opt-in form, click on Add Widget (you can also drag
the GetResponse Web Form box to the desired place);
! click on the down arrow in the GetResponse Web Form
box, select the form you want to use, and Save;
! go to your site, check that the Opt-in form displays
properly;
! opt-in and make sure that the whole process works –
confirmation message provided by GetResponse,
confirmation e-mail, Thank you page link, and the Thank
you/Welcome email.
If you work with themes, please refer to the form installation
procedure of your particular theme.
This concludes the Opt-in installation process.
If you want to go beyond building your email list and want to
bring your leads deeper to your marketing funnel, you have to
adjust the Thank you page and create follow-up pages so that
leads/clients progress through the funnel as intended.
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FB Promoted and Unpublished Posts
The next step after completing your Lead Magnet, Opt-in form
and a Thank you page is to drive traffic to the Lead Magnet, or
rather to the Word Press page where the Opt-in form resides.
In principle FB gives us two options to do so:
1. Promoted (boosted) post
2. Unpublished (‘dark’) post
A Promoted post is published on a Fan page, and thus will be
visible to all visitors of the page. You can pin it to the top of the
page so that the first thing people see will be the invitation to
go to your website and download a Lead Magnet, sign up for a
webinar or a newsletter or otherwise engage with you.
This is great if you have one Lead Magnet for your whole
audience. However, you certainly do not want to fill your Fan
page with endless variations of the same ad.
Thus if you want to send different ads to different segments of
your audience, or if you want to split test various ads, using an
Unpublished post is a far better alternative. This post goes
only to the newsfeed of your target audience, and does not
show on the timeline of your Fan Page (that’s why it’s
sometimes called a dark post).
How to create a FB Promoted/Boosted Post
! Create a post on your Fan Page with that invites people to
download you Lead Magnet. Include the link to the page
with your Opt-in form in the text. It goes without saying
that a catchy headline and an attractive image will
improve your CTR.
! The fastest way to boost the post is directly from your
Fan Page: click on the blue ‘Boost’ button, fill in the form
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that appears (please do not forget to select your custom
audience), and you are ready to go.
! Another possibility is via Ads Manager: click on the down
arrow in the blue bar on the top of you of you FB page
(upper right corner) -> Create Ads -> Boost your post ->
select the page and post -> specify your audience etc. in
the form that will be presented to you.
! And the last option is to promote the post via Power
Editor: Ads Manager -> Power Editor -> Create Campaign
-> select Page Post Engagement -> name the campaign, ad
set(s) and ad(s) -> set up the ad sets and ads by filling in
the respective forms.
How to create a FB Unpublished (‘dark’) Post
! Go to Ads Manager -> Power Editor -> Page Posts -> select
page -> Create new
! Fill in the ‘Create Unpublished Page Post’ form; make sure
to select ‘this post will be used as ad only’. Remarks:
* URL - the URL of the website page with your Opt-in
form.
* Call to Action - select the button that fits the most with
your campaign.
* Display link - when left empty, your URL will be
displayed automatically. However you can insert a short
text here that reinforces your message.
! Click on Actions (under Ads Posts) -> Create Ad.
! Now you can add this ad to any existing campaign and ad
set or you can create a new campaign. When selecting the
campaign objective, if you select
- Page Post Engagement, Facebook will show the ad to
people most likely to engage with it;
- if we want to optimize for conversions, the recommended
choice is Website Conversions. Please note that this
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campaign objective requires that a Conversion Tracking pixel
is created (please see Tracking Pixels Installation below).
If you need more information concerning creating the posts,
please consult these pages:
https://www.facebook.com/business/help/514446411982755
https://www.facebook.com/business/a/online-sales/unpublishedpage-posts
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FB Pixels Installation
Tracking prospects as they proceed through a marketing
funnel is absolutely essential for maximizing your results.
This can be achieved with the FB pixel.
Installing the pixel helps you
! gain insight in the behavior of your audience, specifically
in terms of viewing your ads and converting;
! identify the more and less successful parts of your funnel;
! optimize conversions;
! segment your audience into groups that
- did not opt-in,
- downloaded a Lead Magnet,
- downloaded a Lead Magnet and bought your
introductory offer,
- and so on, all the way through your upsells to your
big ticket offer;
! create lookalike audiences for all these audience
segments (the minimum source audience size is 100
people), so that you can retarget the people who did not
opt-in or did not buy, and – most importantly – you can
promote new offers to a very lucrative, ‘hot’ audience:
people who are like people who already bought from you.
This is exactly where the beauty and strength of FB’s
tracking and optimization tools come in: these tools help
you converge on audiences interested in your offers. The
more you track and optimize, the sharper your targeting
becomes, because you are teaching FB to find people for you
who convert. This is a virtuous, profitable circle: the more
people convert, your ads will be likely shown more, your CTR
will go up and CPC down. So you are selling more and it
costs you less!
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So, how to set up the FB Pixel?
! Go to Ads Manager -> Tools -> Pixels -> Create Pixel.
! Name the pixel and Create it.
! Go to View Pixel Code and copy the code.
! Follow Facebook’s instructions on installing the pixel on
your website (see below).
! Verify the pixel: go to the web page on which the pixel is
installed. The activity should appear in Pixel Traffic graph
and the pixel’s status should be Active.
Facebook originally provided two different pixels - Conversion
Tracking pixel and Custom Audience (retargeting) pixel. These
pixels will be discontinued at the beginning of 2017, and their
functions will be taken over by the FB Pixel.
Installing the FB pixel on the relevant pages of your marketing
funnel will give you insight into the funnel’s performance, and
will enable you to adjust and optimize underperforming parts
of the funnel, as well as create specific audience for retargeting
(pixels -> create audience).
The FB pixel also enables you to track particular events (for
instance ‘complete registration’, ‘add to cart’ etc.) on individual
pages.
Facebook provides and excellent FB Pixel Implementation
Guide, which will lead you step-by-step through the
installation process:
https://www.facebook.com/business/help/952192354843755

You can find more information regarding the pixel here:
https://www.facebook.com/business/help/402791146561655
https://www.facebook.com/business/help/916525851724197
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Disclaimer
This document should be used as a guide and source of information. It is not the
ultimate source on the subject matter, as it represents the experiences and opinions
of the author. Many factors will play role in determining your actual results, and the
author cannot and does not make any guarantees that you will achieve any results
or earn any money with the ideas, information, tools or techniques presented in this
document. Every effort has been made to make this publication as accurate as
possible. Nonetheless, there may be mistakes in delivery or content. The author
does not warrant the applicability or effectiveness of any sites listed in this report.
All links are for information purposes only and are not warranted for content,
accuracy or any other implied or explicit purpose.
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